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GETTING STARTED

Welcome to Deltek GCS Premier, the industry-leading, integrated software solution for government
contracting enterprises.

This Deltek GCS Premier Getting Started guide introduces you to the many features and capabilities
offered in Deltek GCS Premier modules and applications and will help you maximize this product’s full
potential.

This guide provides instructions for accessing the Deltek GCS Premier applications and descriptions of
the menus, toolbars, and other global features.

You can take advantage of Deltek GCS Premier’s functions immediately upon installation. If you have not
yet installed the program software, please refer to your installation instructions.

@] Deltek does not assume responsibility for providing training in the use of Microsoft Windows. We
have designed the GCS Premier manuals with the assumption that you are familiar with such basic
Windows functions as cut, copy, paste, undo, exit, save, and others.

o )
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LOG ON TO DELTEK GCS PREMIER

LOG ON TO DELTEK GCS PREMIER

To start Deltek GCS Premier, complete the following steps:
1. On your Windows toolbar, click Start » All Programs.
2. Onthe Programs menu, click Deltek GCS Premier.

3. On the Deltek GCS Premier menu, click GCS Premier.

4

On the Login dialog box, enter your assigned User ID and password.

2 " = "II'

zer D |

Pazzword |

Enty D |

Company | ﬂ

D ata Directory | ﬂ

k. | Cancel |

5. Click OK.

When you log on, Deltek GCS Premier automatically verifies that your workstation version matches the
version residing on the server. If the two versions do not match, you cannot log on to Deltek GCS Premier
and you must upgrade your workstation to the current server version. This ensures consistent results
across all workstations.

Display Settings

= |If your desktop Display Properties are set to Large Fonts, you should select 1024x768 pixels.
Without this setting certain Deltek GCS Premier screens may be appear truncated. These properties
can be modified by clicking Display in the Windows Control Panel.

= If you use Small Fonts, you should use 800x600 pixels.

= In addition, if your MS Office™ or Startup Menu bar displays on the right side of your screen, some
Deltek GCS Premier screens may appear truncated.

2 Delteki.
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ABOUT DELTEK GCS PREMIER GROUPS AND

MODULES

Deltek GCS Premier is organized through a hierarchical structure of groups, modules, and applications.
The following table provides a brief overview of the diverse functionality contained within each group and

module.

The application functions described here represent just a portion of the resources available. For more
information on specific applications, see Deltek GCS Premier Help Topics in the global menu.

o)

Accounting and Job Cost Group

m Application Functions
-

Timesheets and .
Labor Distribution

PR '
Payroll and .
Human Resources

Accounts Payable

.

Enhances management control of labor by project and increases employee
timekeeping accuracy.

Posts timesheet amounts to Labor Distribution and sets up labor categories,
pay types, trade codes, and contract work.

Reviews each employee's timesheet charges for the year, labor utilization
percentages, and average labor rates.

Interfaces with exterior timekeeping systems.

Streamlines HR functions and reports. Generates payroll automatically from
timesheet data, eliminating the need for duplicate entry.

Supports unlimited payroll history, personnel and employee master records,
employee leave accrual tracking, and employee benefits information.

Prints timesheet history reports by employee and by account.

Tracks employee education and skills and maintains
dependents/beneficiaries information.

Records and posts all invoices, pays unpaid invoices automatically,
provides Standard Aging and Vendor Information reports to bolster cash
flow efficiency.

Processes and tracks subcontractor labor and maintains vendor history
data.

Produces financial statements reflecting the entire company or a single
division for any period during the year.

General Ledger = Offers multiple options for organizational reporting, extensive audit trails for
all transactions, print preview, and automatic bank reconciliation.
Tracks revenue methods, contract ceilings, loaded labor billing rates, and

employee and subcontractor workforces for most types of projects.

Contracts and
Pools

Delteki-



ABOUT DELTEK GCS PREMIER GROUPS AND MODULES

m = Creates and prints invoices in government-specified formats without manual
processing.
Billing and = Tracks billed and unbilled receivables and collections. Monitors costs at all
Accounts levels for increased profitability on contracts.
Receivable
m = Monitors costs by contract. Compares budget-to-actual costs for contract-to-
date, year-to-date, and current accounting periods.
Budgeting = Maintains multiyear budgets with allowance for multiple revisions.
= Tracks indirect rates and updates summary level budgets.
= Tracks individual travel advances and reimbursable expenditures for
lodging, meals, and incidentals.
Travel = Maintains and updates the government’s per diem and lodging table.
= Calculates recommended travel advance amounts.
= Maintains travel advance history by trip and by employee.
= Identifies over-ceiling expenses.
m = Tracks and reports asset cost, depreciation, and disposal.

= Stores inventory data and maintenance and transfer records for both

Fixed Assets company-owned assets and Government Furnished Equipment (GFE).

= Posts depreciation and disposal entries to the General Ledger.

= Records project depreciation for up to five years.

W = Defines part characteristics and stores descriptive information, including
engineering revision status, associated vendors, material planning
Product Definition information, and more.

= Maintains commodity codes and unit of measure conversions.

W Maintains purchase requisitions online, interfaces with inventory planning,
assists buyers in vendor selection, and generates purchase orders
Purchase automatically.

Requisitions

W =  Prints purchase order commitments on Job Status reports automatically.

) = Maintains quality control information, automatically generates vouchers, and
Purcha_smg and reports discrepancies.
Receiving

: Delteki.
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W = Provides online, real-time tracking and control for contract-specific
inventory, company-owned inventory, and government-furnished equipment
Inventory Control and materials.

= Manages inventory at the contract or task level.

= Defines and maintains products and assemblies by components and sub-
assemblies. Maintains single-level BOMs through multi-level relationships

Bill of Materials defined by subassembly part numbers, with capacity for up to 200 levels of
indentures.

= Clones BOMS to create new ones.

=  Streamlines sales order processes from creation through fulfillment.

= Enters, maintains, ships, and invoices sales orders. Automates systems for
completing government contract requirements while improving accuracy
and productivity.

Order Entry

= Stores price information, tracks sales order status, generates bills, and
tracks customer payments.

-9+ Information Access Group

Provides executives with read-only access to the most highly requested reports.
Executive

Information

ﬁ =  Gathers data from different maintenance screens for conversion to

customized outputs.
DataPort ; - ;
= Renders all maintenance screens and corresponding fields for convenient
single-screen display.
= Sorts individual fields from different screens into specific orders.
= Formats the resulting output for email sharing.

This data-mining tool is a separate, add-on module.

ﬁ System Administration Group

SU Maintains user IDs, entry IDs, and contract security.

Users, Security,
and Profiles

Maintains specifications for various system-wide options including general
ledger options, posting options, crash-proofing, and more.
Configuration

Delteki- :



ABOUT DELTEK GCS PREMIER GROUPS AND MODULES

Enables you to schedule and run print jobs during non-working hours.

Batch Manager
ST Exports Deltek GCS Premier data for use in other systems.
System Interfaces

Monitors and repairs Deltek GCS Premier data and generates sequential or

indexed files.

File Utilities

m Runs toolkit programs within Deltek GCS Premier, as advised by Deltek
Support.

Miscellaneous

Utilities

ﬁ Contains custom add-on programs for uploading information into Deltek GCS
Premier from outside user-created files.

File Preprocessors

m Converts or merges existing Deltek GCS Premier data, including employee and
vendor IDs, accounts, and transaction codes.
Data Conversions

AL
Client Care Group

m Provides direct connection to the Deltek Web site, which offers training, support
groups, Webex meetings, newsletters, press releases, FAQs, user bulletins,
Client Care and information on upcoming user conferences and special events.

- Personal Menu

E Provides a customizable menu that builds itself while you work with Deltek GCS
Premier, based on frequency of use, screen name, functions, menu, date last
Personal Menu used, or any specified combination of these characteristics.

; Deltek_i.
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USING DELTEK GCS PREMIER

Deltek GCS Premier’s user-friendly interface lets you easily maneuver between groups, modules,
applications, records, and forms. You can access the Deltek GCS Premier online Help system from any
screen.

The following Deltek GCS Premier interface components are discussed in this chapter:
= About the Deltek GCS Premier User Interface
= Navigating the Deltek GCS Premier Interface
= Groups
= Modules
= Application Folders
= Applications
=  Application Categories
= Application Types
=  Application Menus
= Application Toolbars
=  Global Menu Options
= Deltek GCS Premier Workflow
= Global Features
= Crids
= User Preferences
=  Application Preferences
= Reset Application Preferences

= Reset All Application Preferences

Deltek.i- 7



ABOUT THE DELTEK GCS PREMIER USER INTERFACE

ABOUT THE DELTEK GCS PREMIER USER

INTERFACE

The Deltek GCS Premier interface has a look and feel similar to that of Microsoft Outlook and is designed

to optimize user navigation.

The main window contains two panes: a navigation pane on the left side, from which you select modules
and applications, and a viewing pane on the right side, referred to as the "landing page,” where the
applications display. The graphic below illustrates these components.

H avigation Pane:

A& hierarchical tree structure
gives quick access to all
Rragram areas.

~

v

Thesze are modules.
They contain
application folders.

Theze are application
folders. They contain
applications.

Theze are group bars.

Global Menu: These menus are
always availakble and provide
guick access to frequently used
features.

Thiz mainarea iz called the landing

_page and displays the selected folder's
application icons.

v [ Pracdecd D vy Satug Mg
+ ] Pustsne Ropmiters
v [ Puschusing sad Recsng
v [ 1vvmriory Corind
4 (] e ol Bt
o s
£ kg il
% Cobole
£ Cumtomed Filst
#% Salmn Deder Pyocem:
-
£, Shipping Pt
= e
7 Aoy

They contain modules,

These are icons for
minimized group bars.

=
s Eoty et e

D B it Pl
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NAVIGATING THE GCS PREMIER USER INTERFACE

Navigating the GCS Premier

Step 2 Selecta
malule. Click a
module's icon to
dizplay its application

falders in the nest
level afthe tree L Moluin Usogmant
structure. N
Fipzhame R
w [ Puascbaang s Fasang
|| v [ Ivanioss Conad
- Bl ol Mubonat
Step 3: Select an = e Ern
application folder. i
Click a folder to display — 71| 2ol
tzapplications on the T
landing page. = b

Step T: Select a group.
Click a group bar to
dizplay itz modules in
the navigation windowy
abowve.

T

#.]  You see only those groups and modules to which you have access rights.

Delteki.

User Interface

e Dl G5 Prmmiar

% Pasgosy it

Sotep Flos

A i Ml Kt

Step £ Select an application: After you
zelect an application icon, the application
opens ina separate screen. For example, if

you click the Order Entry Accounts File

icon, the Order Ertry Accounts File
application displays, as shovwn below.




GROUPS

GROUPS

Groups represent the top level of the Deltek GCS Premier hierarchy and always appear as stacked bars
in the bottom section of the navigation pane. When you click a group bar, the navigation pane window

(located above the group bars) displays the modules for that group.

There are six groups in Deltek GCS Premier:

=  Accounting and Job Cost

= Material Management
= Information Access

= System Administration
= Client Care

= Personal Menu

The navigation pane
sindosy displays
modules and

* Deltek GCS Premier
File View Todl Heip

i Matesial Hu-uEurrmt

E m Frouct Disrdion

application folders that —
belong to the group
bar vou select below.

r SabmiFlar

% Pt W szter Fila
£l E Fuchszs Asqumibon:
a m Purchssrg snd Ascerang
£l E Irwarizay Coniied

w1 (] Bty ol Msariniz
= [ e Eriry
7 S Fiae
To maximize all six group F :m: o
H i Ashorren .3
bars, drag the srpl!ttgr bar e
upward, ar to minimize % eenbony
them, drag the bar *, £ Shigping Puocor
% Immicrg
downnard . e

Click @ group bar to display
the modules belonging to
that group in the navigation
windoswe The bar for the Yy
currently active group
dizplays in orange.

T Accounting sed Jab Cast

Thes= iconz represent
minimized groups. Click
an iconto maximize its
corresponding group bar.

10

4

Em‘mm

%  System Sumisistration

&1

b .J\J“k‘h' .

Order E

Selup Files

-
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MODULES

Modules reside on the second level of the hierarchy and contain application folders.

o Deliek GCS Premice

T Aeceounting s Jab Cast

nﬂmm

@ System Admisistration

R

Fia Wiew Tood Help '\
! Mhﬂmﬂt Order E
To expand & module's s -
application folders, click i WE“;::;:“ mlap Filas ¢
a module's plus sign [+] 2 Pt b nsion Pl »
or dauble-click the 17 (] Purchace Floguision: i
tn odule name ar icon. 1 (] Purchaceg mdAnceivig #
1 B Irwvanioey Contrnd )
w1 [ Bty ol hMaperiniz
B m s Eniry
To collapse the contents o SokmFis J
of a module, click the _/ € Caisko: - .,
minu= sign [-] ar doukle- - m[”"";‘mﬁm‘ r
click the module name £ Iveniory r
or icon. I Shipping Fiocass
% Immicrg ?
= Flepostsfinguinos ]/
2

. .J\-ﬁ“‘_*mﬂ_ﬂ_ ,.....JFF.

In the image above, examples of modules include Purchasing and Receiving, Inventory Control, and
Order Entry, all located within the Material Management group.
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APPLICATION FOLDERS

APPLICATION FOLDERS

Application folders are located on the third level of the hierarchy.

When you seled an application
folder in the navigation pane, itz
applications dizplay here in the

landing page .

# Delick GC§ Prermrie:

EIEE
Inthiz example, M Deddur Entry

clicking the Setup g [ rucatinin e

Files folder displayve o anin
thiz folder's [ Pusthore Remisiors
application s in the : Em;:::;“““"
landing page to the o [ e o Mkl

rigkt. NGomen

B Catobo =8 -

B Cugiorar Filn {rcdae Bty Lot Film Eparcimd Ted fila
= Sadss Dcher Pracass
B Wby

% Ehepeg Prens — i

o | |

: Faperd Ui Galin Fes Fle Stiarulorid Temd Aineidl

Chdaa Erinysecraund: Bla

®

In the image above, examples of application folders include Catalogs, Inventory, and Invoicing, all located
within the Order Entry module.

.| The landing page always displays the contents of the most recently viewed folder and does not
refresh until you select a new folder from any group or module. For example, if you are working in
Materials Management » Order Entry » Setup Files (as displayed in the image above), and you
switch to the Accounting and Job Cost group, the view in the landing page remains unchanged until
you select a new folder from one of the modules.

z Deltekin
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APPLICATIONS

Applications reside on the deepest level of the GSC Premier hierarchy. You work in the application dialog
boxes to carry out a wide variety of tasks, such as:

= Entering data for vouchers, contracts, and timesheets
= Viewing and editing existing records for payroll and travel
= Creating and reviewing various labor, accounts payable, and inventory reports

=  Printing and posting reports and checks

#.  This list represents only a small number of available functions.

Fie Yen Tl el

In this exam ple, R T 1 11—

. . |
clicking the Setup N T—— S
Files folder dizsplays S SeapFlm

. . £ Pt Mpp e
this folder's + [ Pachuse Ropiiors
applications in the —!: Em:g:;‘“m
landing page ta the Pl o Madainls
right. e
% Cabdbm =8
% Curomar i {lvdas vy Cmbed Film Sharcad Ted il
S Saisn Do Preces: 1
=L |
% Ehepeg Pusieis — -

: L
P Hapeiviraaa Halin Pt Pl Saarbond Tead Finped

Ovdaa Erisyseraund: N

In this example, clicking the Setup Files folder displays this folder’s applications in the landing page to the
right.
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APPLICATIONS

You can work with multiple applications from diverse groups and modules at the same time.

You can simultaneaushy
run muliiple applications
fram any groupimodule.

14
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APPLICATION CATEGORIES

Maintenance Category

Application Types

Functions

Master

J"' Transactions

E Control

setup
{-’ History

Application Types

Process Category

Use these screens to enter and maintain data. There are two types
of maintenance screens:

= Record maintenance, for creating and maintaining records. For
example, the Vendor Master File under Accounting and Job
Cost » Accounts Payable » Voucher Processing.

= Transaction maintenance, for entering and maintaining
transactions. For example, Enter/Edit A/P Vouchers under
Accounting and Job Cost » Accounts Payable » Voucher
Processing.

Functions

g Posting

General Process

Application Types

Report Category

These screens enable to you to run processes using data
contained within Deltek GCS Premier. For example, the Post
Vouchers to A/P files process updates the A/P files with information
from A/P and non-A/P vouchers. Most process screens contain a
Process button. Process screens are found throughout most
modules.

Functions

—_
|!i—|]:ﬂ| Report

These screens enable you to generate reports based on data
maintained within Deltek GCS Premier. Most often, report screens
are easily identified because "Report” is part of the application title.
The majority of report screens are grouped within the
Reports/Inquiry folder under any given module.

Deltek_i.
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APPLICATION CATEGORIES

Inquiry Category

Application Types

Functions

“ Inquiries

Application Types

These screens enable you to look up information in the Deltek GCS
Premier database. For example, Open A/P Inquiry collects and
displays unpaid vouchers for a selected vendor. These screens are
easily identified because "Inquiry" is part of the application title.
Inquiry screens are most often grouped under the Reports/Inquiry
folder for any given module.

Utility Category

Functions

General Utilities

Purge/Delete

Security/Admin

Batch Manager

Process Manager

Dataport

Rl = o~

Interface

These screens enable you to address occasional problems and
errors. For instance, in the case of a bad check run, you can use the
Clear A/P Check Run utility (Accounting and Job Cost »
Accounts Receivable) to clear the current check run and start over.
If you accidentally closed the A/P year twice, causing the Vendor
Master File to discard the history of payments, you could use the
Update Vendor Master File From Vendor History utility (Accounting
and Job Cost » Accounts Receivable) to restore the payment
history.

The trash can icon is associated with purging data and is most often
available from the Utilities folder.

Deltek_i.
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APPLICATION TYPES

See Application Categories for an overview of the application categories and their associated application
types. By contrast, the table below provides more detailed information about each application type,
including examples and brief descriptions of many popular application functions.

Maintenance Category

Application Types Functions
ITE Use these applications to enter company information, cash receipts
Control and billing, divisions/profit centers, reference numbers, contract

parameters, budgeting options, travel expenses, payroll control,
NASA 533 reports, and to specify which Deltek GCS Premier
features your company will use.

Examples: G/L Control File, Division Control File, Contract Control
File, NASA 533M Control File.

= Master files contain database information on various subjects,

==l Master including employees, time and expense, vendors, reference
numbers, contracts, manufacturer codes, inventory items, and
many others.

Examples: Employee Master File, Employee Time & Expense,
Vendor Master File, Reference 1 Master File, Contract Master File,
Manufacturer Master File, Part Master Files.

== Use these applications to set up accounting periods, billed
o Setup accounts receivable, non-contract accounts, departments and
department expenses, company-wide and contract labor
categories, contract deliverables, employees who are authorized
buyers, requisition costs, sales tax locations and rates, inventory
accounts for raw materials, work in process, and finished goods.

Examples: Chart of Accounts File, Accounting Periods File,
Department File, Labor Category, Contract Deliverables File, Buyer
File, Requisition Cost Type File, Sales Tax File, Inventory Accounts
File.

Use these screens to enter and edit invoices, timesheets, journal
entries, service center usage by cost center or contract, quality
assurance functions for purchase requisitions, purchase orders,
inventory adjustments, and inventory receipts.

)" Transactions

Examples: Enter/Edit A/P Vouchers, Enter/Edit Adjusting Journal
Entries, Enter/Edit Service Center Usage, Enter/Edit Timesheets,
Enter/Edit Quality Assurance, Enter/Edit Purchase Orders,
Enter/Edit Inventory Receipts.

Deltek,i. 17



APPLICATION TYPES

f;‘ Use these applications to view or modify history for vendors,

“=" History timesheets, employee earnings and deductions, employee pay,
journal entry posting, prior year billable data, and current year
billing data.

Examples: Vendor History File, Timesheet History File, Earnings
Record File, Employee Pay History File, Vendor History File, G/L
Header File, Current Year Billing Data.

Process Category

Application Types Functions

Use these applications to print and post A/P and non-A/P vouchers,

¥ Posting voucher distribution journals, cash disbursement journals, labor
distribution by account, general journals, service center allocations,

contract revenue summary reports, inventory journals, and more.

Examples: Print/Post Labor Distribution, Post Vouchers to A/P
Files, Print/Post Voucher Distribution Journal, Print/Post Cash
Disbursement Journal, Print/Post General Journal, Print/Post SC
Allocations, Print/Post Revenue & WIP Journals, Print/Post
Contract Billing Journal.

|:§ﬂ Use these application screens to:

43 General Process =  Establish voucher payment parameters

= Override payment parameters for general payments

= Record unusable (damaged) checks

= Close the A/P Year

= File Federal 1099s on magnetic media

= Reset prenotification codes for employee direct deposit payroll

= Post scheduled pay changes to the Employee Master file
[EMF] and Pay History File

= Update the EMF with new Employee Benefits data
= Update Part Master File standard item costs

= Approve requisition line items

= Generate purchase orders from requisitions

=  Print purchase orders

= View purchase orders by vendor classification

= Generate requisitions from Bills of Materials
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Application Types

Report Category

Examples: General Voucher Selection, Individual Voucher
Selection, Record Unusable Checks, Close the A/P Year, Create
Federal Magnetic Media, Reset Prenotification Codes, Post
Scheduled Pay Changes to EMF, Update EMF from Employee
Benefits, Update Standard Cost from Last Purchase Price, Initial
Approval, approve requisition line items, Quality Assurance
Approval, Worksheet Approval, Purchase Order Register Approval,
Generate Purchase Orders, Print Purchase Orders, Purchase
Order by Vendor Classification Report, Generate Requisitions from
BOM.

Functions

i

il

Report

Print a variety of reports and lists, including check registers, lists of
unpaid vouchers by vendor, open A/P file reports by invoice due
date, vendor history reports, lists of accounts by account number,
lists of departments, timesheet data, Organizational Breakdown
Structure reports, contract and labor reports, statements of indirect
expenses, service center reports, sales tax information, customer
credit information, quality assurance by requisition reports, and
inventory accounts reports.

Examples: Check Register, Open A/P Report, Cash Requirements
Report, Timesheet Edit by Employee Report, Chart of Accounts
Report, OBS Reports, Department Report, Divisional Pool Expense
Report, Service Center Cost, Master, and Usage Reports, Sales
Tax Information Report, Customer Credit by Customer ID Report,
Quality Assurance by Requisition Report, Inventory Accounts
Report.

?
ks  Output

Print a variety of forms and certificates, including Form 1099 for
vendors, Department of Defense Form 250 invoices, Standard
Form 1034, certificates of performance for Labor and ODC, and
sales order invoices by account or invoice. Update bond files and
create magnetic media-convertible data for submission to the U.S.
Treasury.

Examples: Print 1099s, Print Regular Invoices, Print DD Form 250
Invoices, Print Standard Form 1034, Certificates of Performance —

ODC, Form 250 Invoices, Print Standard Form 1034, Certificates of
Performance — Labor, Create U.S. Treasury File, Update Bond File.

Deltek,i.
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Inquiry Category

Application Types Functions
= Produce condensed reports for all account balances, view data for
“ Inquiries specific GL accounts, view audit trail information from Employee

Master File updates, retrieve information for inventory items, and
view data on Bills of Material.

Examples: Trial Balance Inquiry, G/L Account Detail Inquiry,
Employee Master Audit Inquiry, Part Serial/Location Inquiry, Part
Serial History Inquiry, Bills of Materials Inquiry.

Utility Category

Application Types Functions
| Usually located in utility folders across groups and modules, these
applications allow you to purge or delete files for labor distribution,
= Purge/Delete

Accounts Payable, cash disbursements, vendor history, selected
depreciation and disposal detail records, part master files,
purchase and purchasing history data, travel data, and more.

Examples: Purge Labor Distribution, Purge Accounts Payable,
Purge Cash Disbursements, Purge Vendor History File, Purge
Asset Transaction, Purge Part Master Files, Perform Purge of
Purchasing Data, Perform Purge of Purchasing History Data, Purge
Travel Data.

the interface applications allow you to export and import selected
files, including employee files, accounts, ODC transaction codes,
contract work force, trade codes, pay types, and departments.
Import finalized employee and consultant timesheet data from
Electronic Timesheet. Download timesheet data to the ADP®
External Paydata file. Download Deltek GCS Premier data file into
Lotus® 1-2-3® for designing and producing customized reports and
graphs. Download Deltek GCS Premier data into ASCI| files for use
in database management systems. Upload ASCII-formatted data
(from other software) into Budgeting module files. Transmit the
Labor Distribution File to Ceridian®. Download timesheets to the
Paychex® Time0002 Import File. Set parameters for interfacing
Deltek GSC Premier with Cobra™.

@ Mostly located in System Administration » System Interfaces,
=% Interface
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Examples: Export to the Electronic Timesheet System, Electronic
Timesheet — Import Employee Timesheets, Download Timesheets
to the ADP External Paydata File, Export to Spreadsheet Format,
Import Labor and Non-Labor Budget Data, Import Indirect Pool
Budget Data. Ceridian Timesheet Interface, Create Paychex
Time0002 Import File, Cobra Cost Templates, Cobra Extract
Parameters, (Cobra) Interface Configuration and Scheduler.

A

\ o
¥ General Utilities

Set up beginning account balances, update beginning balances
from a prior year, set up new ODC suffix accounts, reset billing
addresses to allow updates through the Customer Address File,
update various budgets using data entered through Detail Budget
Screens, import budget data, generate pay changes for particular
groups of employees, update inventory quantities, average cost,
and year-to-date usage, set up supplementary backup procedures,
restore files from a previous backup, fix corrupted index files, view
all current users, processes, and file locks.

Examples: G/L Beginning Balances, Update Beginning Balances
From Prior Year, Add Suffix Accounts, Reset Billing Addresses,
Update Ref 1 Budgets, Update Department Budgets, Import Labor
Data by Employee, Generate Scheduled Pay Changes, Duplicate
Inventory Master Accounts, Inventory Transaction Reconciliation,
Back Up Files, Restore Files, Fix Data Files, Current Users & File
Locks.

==
& Preprocessors

Use these preprocessor toolkits to prepare and upload data (for
example, ASCII-formatted timesheet, employee master file, journal
entry, and accounts payable data files) that you maintain
separately from Deltek GCS Premier.

Examples: Timesheet PreProcessor, Employee Master File
PreProcessor, Accounts Payable Preprocessor Defaults, Accounts
Payable Preprocessor, all located in the File Preprocessor folder in
the System Administration group.

: Conversion

Using these dialog boxes, convert account numbers, suffixes,
transaction codes, and employee IDs throughout data files for
Deltek GCS Premier. You can also merge two different Chart of
Accounts files from two different Deltek GCS Premier DATA
directories into one Chart of Accounts file.

Examples: Account and Subaccount Number Conversion File,
Convert Account Numbers, Account Suffix and Trans Code
Conversion File, Merge Two Charts of Accounts Files, Convert
Employee IDs, Convert Vendor IDs, all located in the Data
Conversion Module under the System Administration group.

|
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@ Dataport

Located in the Information Access group, this separate, add-on
data-mining tool gathers data from different maintenance screens
for conversion to output that is customizable for departmental and
managerial needs. Select fields from different files, view all
maintenance screens and fields on a single screen, sort output by
designated fields and specified order, export the output in different
formats, and share it via email.

L3
Process Manager

View the process queue and status information on batch jobs,
completion status, applications included in batch jobs, and pending
batch jobs.

Example: Process View and History, located in the Batch Manager
module under the System Administration group.

H Batch Manager

Update the Batch Index File, which contains the index for all
available batches; schedule batch processes; create recurring
processing tasks; export reports to PDF files, text files, and email.

Example: Batch Job Setup, located in the Batch Manager module
under the System Administration group.

? Security/Admin

These applications are mostly located in the Client Care group and
the Users, Security, and Profiles and Configuration modules under
the System Administration group. Establish and maintain passwords
and user IDs, browse user ID records, grant or deny access rights
for particular modules or applications, browse, add, edit, and delete
Entry ID records, control contract access for individuals and groups,
update the Contract Rights File, set up which divisions a user can
access, define system-wide configuration options, configure Deltek
GCS Premier email settings, connect to Deltek to access resources
such as bulletin subscriptions, Webex meetings, enhancements,
FAQs, training, promotions, press releases, user groups and
conferences, and special events.

Examples: Users & Passwords, Individual Application Rights,
Maintain Entry IDs & User Profiles, Contract User Groups, Contract
Rights File, Divisional Security File.
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APPLICATION MENUS

The table below lists all the menu options available in the Deltek GCS Premier applications. However, not
all applications share the same set of menu options. For example, maintenance applications include a set
of Edit menu options, which are not available in report, processing, or inquiry applications. Such
exceptions are noted in the Description column.

Menu Option Description

E_] New (Ctrl+N) Click [ to refresh the current screen. This removes all data for
the current record so that you can enter information for your new
record. This option is also available on the toolbar.

Clone (F8) This option is available only in certain maintenance applications.

Click Clone to copy all information from an existing record into a
new record. To use this function:

1. Display the record that contains the desired information
and click Clone.

2. Enter the new key field. (For example, to copy
information from contract 1008-000 into contract 1009-
008, view 1008-000, click Clone, change the account
number to 1009-008, and save.)

Properties (Ctrl+T)

This option appears only in report and process applications.

Font Tab

Use the Font tab to select font, font style, point sizes, and extra
vertical spacing, and print and preview these fonts in PDF
format. You can also use any monospaced font currently
installed on your workstation. GCS Premier uses Midilex as its
default font; however, Preview to Excel uses Arial Narrow
regardless of the font specified under Properties. Also, Preview
to Text and forms like W2s, 1099s, 1034s, and checks do not
use these font settings.

Font type and size remain consistent with specifications that
existed prior to Deltek GCS Premier Version 3 Service Pack 8.

Expanded Vertical Spacing allows you to increase the white
space between printed lines. Deltek GCS Premier calculates the
number of lines that can fit on a page given the font, style, font
size, extra space, paper size, orientation, and alignment settings.
You are responsible for selecting fonts that do not extend the
printing past the right margin of the page.

Deltek GCS Premier automatically stores user preferences for
future use.

Deltek,i.
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Alignment Tab

Alignment can be found in the second tab of the Properties
dialog box. This printer alignment option allows you to adjust text
placement within the form. 1000 equals one inch. Enter the
number of inches (or fraction of an inch) you would like to move
the text, as well as the direction. Deltek GCS Premier tracks your
initial entry, so if you need to adjust the text further, reduce or
increase distances based on your original entry.

Align Tab (Ctrl+A)

Align is only available in applications that print to forms, such as
Print Payroll Checks and Print A/P Checks. The printer
alignment option allows you to adjust form alignment and
placement of text on forms. 1000 equals one inch. Enter the
number of inches (or fraction of an inch) you would like to move
the text, as well as the direction. Deltek GCS Premier tracks your
initial entry, so if you need to adjust the text further, reduce or
increase distances based on your original entry.

P
“% Print Preview (Ctrl+W)

This option is available only in report and process applications.

e
Click EMlto review your report on screen before printing a copy.
You can preview your print job in text, PDF, or Excel formats.

= Text allows you to view the report in text format.

= PDF allows you to view the report in PDF format. If your
computer lacks PDF viewer software, Print Preview defaults
to text format.

= Excel allows you to view the report in Microsoft Excel. This
feature assists in analyzing and preparing multiple types of
reports.

If you have already set the report style preference in the User
Options screen, your report displays in your designated format.
Otherwise the Report Format dialog box displays, where you can
specify the format for your report.

& print (Ctrl+P)

This option appears only in report and process applications.

Click =% t0 select your printer, number of copies, and other
print options.

The items listed within the Printing header frame describe the
printer to which the output will be directed. The current status of
the printer, the type, and location are all listed below the printer
name.

You can use the drop-down list to choose a different printer.
Click the down arrow beside the current printer to display a list of
valid printers, from which you can choose a different printer.

24

|
Deltek S




Deltek GCS Premier 5.0 Getting Started Guide

Use Properties to view your chosen printer’s current settings.

Under the Print Range frame, you can print all pages of a report,
a range of pages, or a specific page.

Under Copies, specify the number of copies to be printed.

40 send (Ctri+M)

This option is available only in report and process applications.

Click '-{j to send an email message with an electronic copy of
the report. You can send the report in Excel, PDF, or text format.
Once you select the report format, a blank email message
displays.

If you have set the report style preference in User Options, the
report is sent in the designated format. Otherwise, the Report
Format dialog box displays, on which you can set your
preferences.

L
E Save (Ctrl+S)

This option is available only in maintenance applications.

Ll
Click E to save a record that you have added or updated.
After you save the record, a blank record displays in Add mode.
Save is also available on the toolbar.

Save and Continue (Ctrl+U)

This option is available only in maintenance applications.

Click Save and Continue to save a new of updated record. After
you use this option to save your record, the record continues to
display in Browse mode.

This option is available only in maintenance applications.

Click X to delete a record. After you confirm that you wish to
delete the displayed record, Deltek GCS Premier displays the
next available record. This option is also available on the toolbar.

Exit

Click Exit to close the current application. This does not log you
out of Deltek GCS Premier.

Edit Menu

Menu Option

Function

Add New Line (Ctrl + A)

This option is available only in maintenance applications.

Click this option to add a new line of information to a table
window grid. Deltek GCS Premier automatically places your
cursor in the next available line within the grid.

Deltek,i.
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Delete Line (Ctrl +D)

This option is available only in maintenance applications.

Click this option to delete an existing line from the table window
grid. To enable Delete line, highlight the line to be deleted by
double-clicking the column located to the far left. This column is
located immediately before the first input column. After you
highlight the row, Delete line enables.

EE Copy Line (Ctrl C)

This option is available only in maintenance applications.

Click EE' to copy an existing line within a grid. First, highlight
the line to be copied by double-clicking the far left-hand column.
This column is located immediately before the first input column.
After you highlight the row, Copy line enables.

Ea Paste Line (Ctrl V)

This option is available only in maintenance applications.

Click Ea to place a line you have copied from another location.

Menu Option

Function

% Previous (F11)

This option is available only in maintenance applications.

Click &' to view the record immediately preceding the currently
displayed record. This option is available on the toolbar.

W Next (F12)

This option is available only in maintenance applications.

Click ' to view the record immediately following the currently
displayed record. This option is available on the toolbar.

Ea Go! Inquiry (Ctrl+l)

This option is available only in inquiry applications.

Click E& to initiate the inquiry process. Excepting Job Summary
Inquiries, inquiry results usually display in Excel PivotTable
format. This option is also available in the toolbar.

26
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Q Lookup (Ctrl+L) Click Q to locate valid values for a particular field. Your cursor
must be placed in a field in order to use Lookup.

You can also use Lookup to execute searches. For example,
you need to review a particular contract, but you know only that
the contract number begins with "19." Using Lookup, enter the
known value into the Starting with field. In this case, enter
"1900." Deltek GCS Premier then lists all valid values from 1900
and higher. You can then select the contract number from the
list.

If a search produces more than one page of results, click More
to display the next page. More disables if there are no additional
values available for display.

Lookup is also available on the toolbar.

M This option is available only in maintenance applications.
Find (Ctrl+F)

Click M to search the files for records. When Find is activated
in a blank screen, it displays the first record in the file. If you
know the record you want to find, enter the key information and
then click Find. If the requested record does not exist in the file,
the next available record displays. This feature is also available
on the toolbar.

24 calculator (Ctrl+F11) Click E to launch the calculator. This allows for quick
calculations without leaving Deltek GCS Premier. This option is
also available on the toolbar.

E Calendar (Ctrl+F12) Click ‘E for quick access to past, current, and future dates.
This option is also available on the toolbar.

Tools Menu

Menu Item Function

User Options Click this option to set user preferences in the User Options
screen. These options, which are determined during login, are
non-application specific. Changes take effect only when you click
OK on this screen and log out of Deltek GCS Premier.
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Application Preferences

Click this option to apply default values for the application
screen. These application-specific values are determined during
application startup. Changes take effect after you close the
application screen.

You can save the following preferences:
= Screen size
= Screen position on desktop

= Last tab accessed in the screen (for applications with more
than one tab)

You can choose between your previously-saved user application
preferences and Deltek’s default preferences.

Reset Application Preferences

Click this option to reset your application preferences to Deltek's
default values. This deletes your saved preferences for that
application in favor of Deltek’s default settings.

Help Menu

Menu ltem

Function

Deltek GCS Premier Help Topics
(F1)

Click this option for Help information concerning the currently
displayed application.

From the Help topic screen, you can also access documentation
for any other application within the current module. Use the
Contents, Index, or Find tabs to view additional help topics.

I.'..i Deltek GCS Premier
Screen Capture

Click l-i to capture a screen shot of your current desktop
display and automatically attach the image to an email message
(you will need to enter the Deltek customer support emalil
address).

This feature allows Deltek Technical Support to view your current
problem or setup issue.

Depending on the user preferences you select in User Options,
your screen capture attachment can be either zipped or
unzipped.

This option is also available on the toolbar.

28
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& About Deltek GCS Premier

Click & to view a detailed summary of your system setup. The

initial screen displays your current version of Deltek GCS Premier,
specifics of the Dtshared.ini and Dtlocal.ini files, numbers of active
and licensed users, and your Deltek support identification number.

Click License to view all add-on modules. Add-on modules
currently available in Deltek GCS Premier appear in bold face,
while those available in Deltek System1 are disabled. The add-
ons purchased by your organization are indicated with a red
diamond.

Click Product Information to view information on your current
Deltek GCS Premier software version and installation date, as well
as information on your workstation's operating system.

Click File Info to view program file information for Deltek GCS
Premier and Deltek Systeml, including file name, date, version
number, and size.

Click System Info to view your workstation’s technical
information. This information will help Deltek Technical Support
assist you.

|
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APPLICATION TOOLBARS

Option Function

D New Click E]to refresh the current screen, which discards all
previously entered information for that screen. You can then
enter information for a new record.

This option is available in maintenance applications only.

x Delete ) . .
Click ¥ to delete the displayed record. Once you confirm,

Deltek GCS Premier deletes the record and then displays the
next available record in the file.

This option is available in maintenance applications only.
= Save

Click & save a record that you have added or updated. After the
record is saved, a blank record displays in Add mode.

[+ . This option is available in maintenance applications only.
Previous

Click ' to view the previous record.

e Next This option is available in maintenance applications only.

Click 'se'to view the next record.

M This option is available in maintenance applications only.
Find

Click this icon to search the file for records. When you click L)
from a blank record, Deltek GCS Premier displays the first
record in the file. If you know the record you want to find, enter
the key information and click 8. If the information you enter
matches a record in the database, then that record displays. If no
match exists, the next available record displays.

@ . , This option is available in process and report applications only.
Print Preview

Click Alto review the current report before you print a copy.

From the drop-down list, you can select from Excel, PDF, and
text formats.
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= Print

This option is available only in process and report applications.

Click & to print the report. Please see the Printing menu
discussion for printer definitions and settings.You cannot use this
feature to change the default printer.

4 send

This option is available only in process and report applications.

Click =& to email an electronic copy of the report. Use the drop-
down list to specify Excel, PDF, or text format. After you select
the report format, a blank email message displays.

If you have previously set the report style preference in User
Options, the report automatically attaches to the email in the
designated format. Otherwise, the Report Format dialog box
displays, on which you can specify your preferences.

0
% Lookup

Click X to locate valid values for a particular field. In order to use
Lookup, your cursor must be located within a field.

You can also use Lookup to execute searches. For example:
you need to review a particular contract, but you know only that
the contract number begins with "19." Using Lookup, enter the
known value into the Starting with field. In this case, enter
"1900." Deltek GCS Premier then lists all valid values from 1900
and higher. Select the contract number from the list.

If more than one page of valid values exists, click More to display
the next page. This icon is shaded if there are no additional
values available for display.

[& Go! Inquiry

This option is available only in inquiry applications.

Click [& to proceed with the inquiry process. Excepting the Job
Summary Inquiry, data displays in Excel PivotTable format.

Le Screen Capture

Click k&# to take a screenshot of your current desktop and
automatically launch your email with this screenshot attached
(you will need to enter the Deltek customer support email
address). The screenshot helps Deltek Technical Support identify
your current problem or setup issue.

Depending on the user preferences you select in User Options,
the screen capture attachment can be either zipped or unzipped.

3 Calculator (Ctrl+F11)

Click 3 to launch the calculator. This allows for quick
calculations without leaving Deltek GCS Premier.

i Ml
18] calendar (Ctrl+F12)

L=l
Click & for quick access to past, current, and future dates.

-]
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GLOBAL MENU OPTIONS

7 Deltek GCS Premier
File Wiew Tool Help
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The global menu is located in the top left portion of the main window, directly above the navigation pane.
These menu options are always accessible. The four menu categories are:

= File: Provides convenient access to your ten most recently accessed Deltek GCS Premier
applications. You can also click Close Flowchart Menus to reset the landing page to the Deltek
splash screen.

= View: Offers a calculator and calendar for your convenience.

= Tool: Includes User Options for setting global defaults for zipping email attachments and screen
captures, as well as selecting default format for your report previewer (text, PDF, or Excel), printer
options, and the option to reset all application preferences to Deltek Defaults.

= Help: Click Deltek GCS Premier Help Topics to access help topics for specific applications. Click
About Deltek GCS Premier to view license, product, file, and system information, as well as
contents of .ini files.
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DELTEK GCS PREMIER WORKFLOW

On landing pages for many Deltek GCS Premier application folders, certain applications are connected
with graphical lines, which are called workflow lines. Workflow lines display on these landing pages for
two reasons.

First, workflow lines help orient newcomers to Deltek GCS Premier by depicting the preferred order of
application usage. As an example, let’s look at the Voucher Processing folder in the Accounts Payable
module. In this folder, you enter and post A/P Voucher or unpaid invoices.

Sample Screen
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|

The workflow lines depict the following process:
1. You enter or edit an unpaid voucher (or invoice) using the Enter/Edit A/P Vouchers application.
2. You review or edit the list of all unposted vouchers using the Voucher Edit Report.
3. Unposted vouchers are then posted to Accounts Payable using Post Vouchers to A/P Files.
4

You then review the original voucher and others by running five different reports that derive from
the A/P Files: Open A/P Report, Cash Requirements Report, Voucher & P.O. Register, Vendor
History Report, and Vendor P.O. History Report (the voucher can also be selected for payment
and posted to the General Ledger, located in the Check Process folder under Accounts Payable).
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Second, workflow lines assist experienced users because they illustrate Deltek GCS Premier program
logic by depicting which applications feed into which applications. To illustrate, we’'ll pick an example from
the Timesheets folder (Accounting and Job Cost » Labor Distribution):

Sample Screen
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The workflow lines on the landing page show that:

1. Labor cost data flow from the applications Enter/Edit Timesheets, Timesheet Edit by Employee
Report, and Timesheet Edit by Account Report into the Labor Distribution Journal (Print/Post
Labor Distribution).

2. The Labor Distribution Journal in turn feeds data into the Labor Summary File, Timesheet History
File, and Divisional Labor File.

The Labor Summary File, Timesheet History File, and Divisional Labor File are stand-alone applications
and not directly related to the Timesheets workflow process discussed here. However, the workflow lines
illustrate that data contained in these files derive from posting the Labor Distribution File.
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GLOBAL FEATURES

Browse, Add, and Change Modes

Within an application, you can browse, add, change, or search for a record. The current mode displays in
the bottom right corner of the application screen.

Sample Screens

B0 Extimate-To-Complbete Amounts

Bl Yaw Iooks belo
XE UM 0T

Conlract Informaton
Ireciec rcumed &

Conlract Ircuared Revized ETC Rewvimed

- [ =l | L=

Conlract Arnonlt
Cortract Vakas Sudiix Fooks Cast of Money
s [ | Suafu: [ Incugied [ ETC | -
Budgelsd Vakss | = S
Qg
Total Incusned |
Qg
Totad ETC 1 1 T | gl
[ oum 1 ' i i

Total LREAC |
0.00

Totdl % Complete [ [ I I T _Iﬂ
000 { K .

|
< Seaich |

Deltek GCS Premier applications offer the following modes:

= Add: When you first enter a screen or select New, the Add mode automatically enables.
= Browse: When you select Find, the Browse mode enables.
= Change: When you edit an existing record, Deltek GCS Premier switches to Change mode.

= Search: If you attempt to change a key field while in Browse mode, Deltek GCS Premier
automatically switches to Search mode. This enables you to look up a particular record using any of
the key fields. To exit Search mode, select File/New from your toolbar.
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When you modify a non-key field while in Browse mode, Deltek GCS Premier switches to Change mode,
and returns to Browse mode after you save the record.

Key Fields vs. Required Fields

Generally, all key fields in an application dialog box are required fields. The field names for key fields
display in bold type. Notice that when you position your cursor within a key field, the cursor’'s appearance
changes to a key symbol. If you skip a required field while adding or editing a record, an error message
lists the fields that you missed. You must correct errors before you can save a record.

Error Dialog Boxes

Error dialog boxes report both errors and warnings. You must correct errors contained in your record
before you can save it, but you can either address or ignore warnings.

Grids

Grids display matrixes of information. The columns of the matrix represent all of the components needed
to complete a line of the matrix. You can customize a grid’s appearance (changing the grid view does not
affect the data stored in that grid). For example, you can move columns within your grids. To move a
column, highlight the column title. After the column title attaches itself to your cursor; drag it to the desired
location.

You can also sort column information within a grid. To sort data in a specific column, double-click the
column title. This sorts your data in ascending order. To sort the data in descending order, double-click
the column title again.

You can divide grids that display horizontal scroll bars into two panels. This feature is helpful for wider
grids, such as the Enter/Edit Timesheets application (located in the Timesheets and Labor Distribution
module) and the Enter/Edit A/P Vouchers application (in the Accounts Payable module). To divide a grid
into two panels:

1. Click the black rectangle located in the bottom left corner of the grid.
2. Drag and drop this rectangle to the point where you want the grid to be spilit.
Information in the left panel continues to display while you scroll in the right panel.

You can delete multiple lines within a grid. Select the lines you want to delete by pressing your SHIFT or
CONTROL keys.

Grid Preferences

When you close the application and select User Preferences, Deltek GCS Premier saves your current grid
settings (such as changes to column order and width) to the {USERID} #.XML file. Any previous grid
settings in that application are overwritten.

When loading applications containing grids, User Preferences reads the XML file that contains these
specifications and loads these values.

There are two situations where Deltek Default settings load automatically:

= If you load an application where the Deltek Defaults check box has been selected prior to closing that
application the previous time

Or
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= If your XML file contains no saved user preferences.

Select User Preferences while the application is running to set grid settings to the values contained in
the XML file. Click Deltek Defaults to set the grid settings to the Deltek Default values.

Select Reset Application Preferences to delete the XML file grid settings in favor of the Deltek Defaults.

Deltek.i-
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USER PREFERENCES

With User Preferences you can save your current Deltek GCS Premier settings, such as email settings,
the location and size of the screen, your preferred mode for previewing reports, and others. This
increases your productivity as it reduces time expended on repetitive tasks such as selecting the PDF
previewer. Through User Preferences you can also override your own preferences and return to Deltek
GCS Premier defaults.

Deltek GCS Premier User Preferences also tracks grid column order, column width, and grid splits or
fences.

The following are saved settings:
= User Options
= Default for email attachments (zipped/unzipped)
= Default for screen captures (zipped/unzipped)
= Default previewer (text/PDF/Excel)
= Suppress 'Form Loading' message
=  Application Preferences
= Main form size
= Main form position
= Lasttab accessed (for applications with tabs)
= Most recently accessed applications
= Tab of last accessed application for every module

= Last 10 accessed applications

#@.]  When a user is deleted from Users & Passwords in the Users, Security, and Profiles screen under
System Administration, the saved User Preferences settings for that user are also deleted.

Access User Options from the Tool Menu

GL Chart of Accounts File

Eile Wiew | Tools | Help
}( z User Options...
| #pplication Preferences 4 User Preferences

Reset Application Preferences @ Deltek Defaults |

Account ; ; ;

Account Hame |

Account Type |.-’-'-. Azzet ﬂ

.

(Ve Vs Yo |
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The Tool menu contains three items related to user preferences:
= User Options

= Application Preferences

= Reset Application Preferences

%.]  These menu options are accessed from the Tools menu that is available from within each
application.
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USER OPTIONS

The User Options dialog box enables you to select preferences related to email attachments, screen
captures, and formats for previewing reports. These options are determined during the login process and
changes take effect only when you click OK on this screen and log out of Deltek GCS Premier.

W User Options E'
Email Attachments Screen Captures
i f* Fipped
" Unzipped " Unzipped

Default Previewer |TEXT -

[ Supprezz 'Form Loading' meszage

k. Cancel

@.]  The first ime User Options displays, Deltek GCS Premier uses Deltek defaults. The Deltek defaults
are "Zipped" for Email Attachments, "Zipped" for Screen Captures, "TEXT" for Default Previewer,
and the Suppress 'Form Loading' message check box is clear.

Email Attachments

Use the options in this group box to determine the format for emailing attachments from Deltek GCS
Premier. You can send email attachments as either zipped or unzipped file(s). User Options affect only
attachments sent via the File » Send menus and Send on the toolbar. Attachments you send via the
Email Data Files and Software Audit Log screens are not affected by your selection here.

Screen Captures

Use the options in this group box to determine how to capture a screenshot and attach it to your email.
Capture Screen and Email is available on the toolbar, represented by the camera icon ( k& ), or in the
Help menu by selecting Deltek GCS Premier Screen Capture. You can send screen captures by e-mail as
either zipped or unzipped files.

Default Previewer

=  Text L'
= PDF m

=  Excel %
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Use this field to select a default preview tool to preview a report before printing it. You can access Print

Preview by clicking the Print Preview toolbar icon ( s ), or by selecting Print Preview under the File
menu. Reports viewed through the print preview feature can be displayed in three formats: Excel, text, or
PDF.

@ The Excel option disables if Microsoft Excel is not installed on your computer, or if the report you
are about to process is not supported in Preview to Excel. For more information, see the
Preview/Send to Excel section in this manual. Similarly, if no PDF viewer is installed on your
computer, that viewing option is also disabled.

Suppress ‘Form Loading’ message

Select this check box to suppress the "Form Loading" message, which alerts the user that a screen is
being loaded.

“&J The "Form Loading" message can be suppressed only after the user has logged into Deltek GCS
Premier.
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APPLICATION PREFERENCES

Use Application Preferences to apply default values for the application screen; these values are
application-specific. These options are determined during the application startup, and take effect only
after you close the application screen.

&L Chart of Accounts File

File Wiew | Tools | Help
X - ser Opkions. .. 7
| Application Preferences k Liser Preferences

Reset Application Preferences IE Deltek Defaults |

Account ; ; ;

Accaunt Mame |

Account Type |.-'1‘-. Azzet j

: — . P

The Application Preferences can save the following:

= Screen size

= Screen position on desktop

= Last tab accessed in the screen (for applications with multiple tabs)

You can choose between the saved user application preferences or the Deltek default preferences.

User Preferences

When you close an application, your current grid settings (such as changes to column width, column
order, and split) are saved to the {USERID} #.XML file, providing you have selected User Preferences
(Tools » Application Preferences). Any previous settings for the grid(s) in that application are
overwritten.

When starting an application containing grids, User Preferences reads the XML file that contains the grid
column order, column width, split and loads previously set values. Conversely, when Deltek Defaults is
selected, the default values load the next time you start the application. If the XML file does not contain
any saved user preference settings, the default settings automatically load.

Select User Preferences while the application is running to change the grid settings to the values from
the XML file, or click Deltek Defaults to change the grid settings to the default values.

Select Reset Application Preferences to erase the grid settings in the XML file and return the grid
settings to the Deltek default values. In this case, even if User Preferences is selected, the previous
settings do not take effect.

“&J When you open an application, Deltek GCS Premier obtains the application’s grid default settings.
When you activate User Preferences in the {USERID} #.XML file, it sets the grid settings to the
values stored in that file. If deactivated, it sets the grid settings to the Deltek Default settings.
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REARRANGING COLUMN ORDER

You can arrange your grid columns by dragging and dropping the column headers. To move an entire
column(s) to a different location:

1. Press and hold the mouse button within the column header area. Notice that the pointer’s
appearance changes to a cursor arrow with a small box at its lower right corner. The divider at the
left edge of the selected column(s) becomes enlarged and highlighted.

Sample Screen

YA Auto Creation Accounts File

Dept/Trans Descnpton
FURMITURE & FI<TURES : ISC
OFFICE EQUIPMENT | oo | |MISC
LEASEHOLD IMFROVEMENTS M55 (000 (00 (00 | MiSC
FURCHASED SOFTWARE | {00 ] [MISC

Heady

2. Drag the divider to the desired location and release the mouse button. The columns you have
moved remain selected.

If you drag the divider to a position within the currently selected range, no movement occurs.
Additionally, you cannot move a column that is not selected.
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RESIZING COLUMN WIDTH

= Placing the mouse pointer to the right edge of a column header changes the pointer's appearance to
a horizontal double arrow; you can click and drag to resize the column.

Sample Screen

F& Auto Creation Accounts File

Fie Edt View Took Help

HENEEEREC

Dept/
Aseourt Nate ‘ﬁa Sub | s Ttm Dept/Trans Deserpbion
(e ]
FURNITURE & FI<TURES ms B (00 |00 [MISC
OFFICE EQUIPMENT |52 (000 (00 |00 [MISC
LEASEHOLD IMPROVEMENTS  |M53 (000 |00 |00 |MISC
FURCHASED SOFTWARE (0154 [000 (00 |00 |MISC

Heady

= Dragging the pointer to the left narrows the column, while dragging it to the right widens it.

= Dragging the divider to the farthest left portion of the grid hides the column. To show the hidden
column, move the pointer over the succeeding column divider until it changes to a horizontal right
arrow. Drag the divider to the right to make the column visible and adjust its width.

Sample Screen

F& Auto Creation Accounts File

Dept!
acat | SEF D Account Nome Trans Diepl/Trans Dsscription
M (000 | FURNITURE LFE<TURES (00 MISC
0152 |00 | OFFICE EQUIPMENT 00 [MISC
0153 |00 |LEASEHOLD IWPROVEMENTS |00 |MIEE
0154 |00 |PURCHASED SOFTWARE (o0 [MisC

Heady
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GRID SPLITS

By default, the grid has only one split. If the horizontal scroll bar is visible, the grid displays a split box
immediately to the left of the horizontal scroll bar. You can make the horizontal scroll bar visible or
invisible by resizing the column(s) width.

To separate a grid into two panels, click the black rectangle in the bottom left corner of the grid. The
pointer changes to a double vertical bar with a down arrow. Drag and drop this rectangle to the location
where you want to split the grid. Information contained in the left portion of the grid remains in view while
you scroll on the right side. You can create only two splits for any Deltek GCS Premier application that
has a grid control.

Drag the dividers left or right to adjust the widths of the adjacent splits. As with columns, you can drag the
dividers all the way to the left to hide or delete a split.

Sample Screens

F& Auto Creation Accounts File

File Edit Wew Tools Help

@ Qu o=
Act Sub Account Mame Dept! Tran: Code Dept/Tranz
51 000 [FURMITURE & FI=TURES an
a2 000 [OFFICE EQUIPMENT an
me3 000 [LEASEHOLD IMPROVEMEMTS an
054 000 [PURCHASED SOFTwWARE an
# |l

Ready
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F& Auto Creation Accounts File

File Edit Wew Tools Help

e
Act Sub Account Mame Dept! Tran: Code

51 000 [FURMITURE & FI=TURES an

a2 000 [OFFICE EQUIPMENT an

me3 000 [LEASEHOLD IMPROVEMEMTS an

054 000 [PURCHASED SOFTwWARE an

@l/

Dept/Tranz

Ready
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RESET APPLICATION PREFERENCES

Resetting your Application Preferences to Deltek's default values means your saved user preferences for
that application are deleted in favor of the Deltek defaults. These defaults take effect the next time you
execute the application.

File Wiew | Tools | Help

= User Options, .. ’
application Preferences 4 ‘

| Reset Application Preferences S{

=1

Type of R

Timeshe

Entry 1D Timezheet D ate . .

[ Al Starkirg /

DR e el T 0

#.] Applications that are currently running when you select this option are not affected.

Selecting this option resets your Report Properties (File » Properties) to the Deltek defaults. The
Deltek defaults are Midilex font, Regular style, an Expanded Vertical Style of "0" and a font size of
"Fit to page width." The alignment also resets to "0".

Reset All Application Preferences, located in the global Tool menu, resets ALL of your current
application preferences to Deltek's default values; in other words, it deletes your saved preferences for all
applications within GCS Premier.

7 Deltek GCS Premier r
File Wiew B8 Help L.
Idser Options., .. )
1 £ Character Application Prinking m Fixed Assets E
STES S Control Files ?
NS4 533 Repotting }
+ m Billing and Accounts Receivable

| ERRr g g | gt et
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DELTEK GCS PREMIER AND MICROSOFT EXCEL

Microsoft Excel PivotTable

Deltek GCS Premier presents the Data Screen in a Microsoft Excel PivotTable, which you can use to
export your information directly to Excel. Filter your data by selecting the filter drop-down arrow that is
present in every field. The filter drop-down arrow displays a list of the filter field records. Consult the built-
in Excel PivotTable Help for assistance in manipulating the data display.

Drag and drop data fields to the Outer Row field or the Outer Column field to provide a customized
grouping for the total, or subtotals, or any other grouping functions. With this simple drag-and-drop
operation, you can view data for all employees residing in a particular state. Using the Excel PivotTable,
you can also include subtotals in the query results:

1. Click the field header.
2. Right-click to display the context menu.

3. Select the AutoCalc menu, from which you can then select the function you wish to perform.

@  The Inquiry Report (which you generate from the Data Screen by clicking Print Preview) displays
all data fields regardless of which fields were selected in the Input Screen.
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GRID RESIZE

Using Grid Resize, you can maximize a grid within the application screen.

You can maximize a grid only within a single record. It is automatically restored when you perform any of
the following actions:

=  Saving the current record
=  Browsing another record
= Clearing the form

Grids on dialog boxes are not included in this feature.

Using Grid Resize

To activate Grid Resize:
1. Right-click any enabled grid column. The Grid Resize pop-up menu displays.
2. From the shortcut menu, select the appropriate option.

The Grid Resize shortcut menu cannot activate if the grid is disabled.
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GRID RESIZE OPTIONS

Maximize

Use Maximize to enlarge the grid within the application that contains it. The enlarged grid displaces the
other fields that were formerly displayed on the application screen. This option disables after you
maximize the grid.

Sample Screen - Before Selecting Maximize

50

BO| Labor Detail Budgets by Account

File WYiew Tools Help

X UM

Fizcal Year
2008 -

Option
OR -

Account

T

Employee

Department
Labor Category

pabe

Referencel

WBS

[~ Allow entry of non-labor accounts

18

Pd Fate Hours Dollareﬂ
|FYZDDB ORIGINAL BUDGET 2 0.0000 0o

3 0.0000 0o
|DHIGINAL 4 0.0000 0o

] 0.0000 [ili]
| B 0.0000 0o

7 0.0000 [ili]

g 0.0000 0o
| ] 0.0000 1]

10 0.0000 [ili]
| 1 0.0000 1]

b | 12 00000 m'
| -
< | i
| Awerage
Hourly Rate Total Hours Total Dollars
| | 00000 | 0o | 0.00
Spread/Fill...
Add
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Sample Screen - After Selecting Maximize

BO, Labor Detail Budgets by Account

File W¥iew Tools Help
XE el Q e |
Pd Rate Hours Dollars |
y | 1 Bl ooy 00 0.00
2 0.0000 [iki] 0.o0
3 0.0000 0.0 0.00
4 0.0000 oo 0.o0
5 0.0000 [ili] 0.o0
E 0.0000 0.0 0.00
7 0.0000 [ili] 0.o0
] 0.0000 [ili] 0.oa
9 0.0000 0.0 0.00
10 0.0000 [ili] 0.o0
11 0.0000 0.0 0.00
12 0.0000 oo 0.o0
I
ke
| Add
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Restore

Use Restore to return the grid to its original size. This option enables only while the grid is maximized.

Sample Screen - Before Selecting Restore

BO | abor Detail Budgets by Account

File Wiew Tools Help
X JuMQ e 8%
Pd Rate Haourg Daollars
1 0.0000; 0n o.o0
2 0.0000 0.0 0.0o
3 0.0000 0.0 0.00
4 0.0000 0.0 000
5 0.0000 ! o.oo
» E 0.0000 0.0o
7 0.0000 0.00
g 0.0000 0.00
3 0.0000 o.o0
10 0.0000 0.0o
11 0.0000 0.00
12 0.0000 0.00
Add

Sample Screen - After Selecting Restore

BO | abor, Detail Budgets by Account - SteveTest

Fil= Wiew Tools Help
XE wwM e 0%
Fiscal Year Pd Rate Hours Dallars «
2006 - % |FY2DDB ORIGIMAL BUDGET » 1 oo
Option 2 0.0000 i1}
OR - |ORIGINAL 3 0.0000 na
4 0.0000 i}
Account
’— ,— ,— | [ 0.0000 oo
|5 0.0000 i1}
Emplnyce 7 0.0000 00
| a 0.0000 i}
Department 9 0.0000 0.0
- [ 0 f.0000 (]
Labor Category " 0.0000 0.0 i
| 12 0.0000 i} -
Referencel I‘—l—l L
| Average
WBS Hourly R ate Total Hours Total Dollars
[ [ [ oooon | oo | 0.00
[ Allows entry of norrlabor accounts Spread/Fill
Add

@ When the Error Report dialog box displays during validation processes, the grid automatically
returns to its original size.
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PREVIEW/SEND TO EXCEL

Use Preview to Excel to view and email reports in Excel format. This feature will help you analyze and
prepare a variety of reports.

@, Arial Narrow serves as the default font, regardless of selections made during setup
(Properties/Fonts).

Accessibility
You can access Print Preview to Excel and Send to Excel in two ways.

= From the File menu, select Print Preview or Send. The Report Format dialog box displays. Excel is
included as one of the options in the Report Style.

=  From the toolbar, click Print Preview or Send and select the drop-down to display the different report
formats.

Print Preview Format

File Wew Tools Help

g | e o Aula
L fead|7|88 gl ™ A bl N

3E Prink Preview in Excel Q
BT Prink Preview in PDF
L & Prink Preview in Text i~ Both

Employes

- P T

.

xﬂ e Yag |

Send Format

FA Employee Insurance Repor... |Z||E

File Wiew Tools Help

™ ciela

- : i - H
MTE gt O e B

Z& sendin Excel Format [,\}
Employes 5 '2 Send in POF Farmak

(¢ Hctive | L g Sendin Text format

S Er}a—--i-ﬂx
'\"'"-..-' T RO ERRR w«f\\, et
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PREVIEW/SEND TO EXCEL

In both the Report Format dialog box and the Report Preview drop-down list, the Excel option disables
if the processed report is not supported by Preview to Excel. If the application is supported by Preview to
Excel but Microsoft Excel is not currently installed on your computer, Report Format disables. Instead, the
Report Preview drop-down list displays the following error message: “No version Info Available! Version of
Excel is not supported.”

Generating Preview/Send

Preview/Send to Excel employs a series of technical processes to generate a report in Excel format. One
such process involves actually generating a text format of the report. Because of this, Excel processing
can take longer than generating a text report.

Applying Format Using Add-in

Once Deltek GCS Premier generates the Excel output file, you can use the add-in tool to apply special
formatting, such as showing page breaks and rolling up page headers. Shorter reports format more
quickly, while multiple or larger reports can take longer since formatting must be applied to each page.
Instances may also occur during the formatting process where the Excel screen turns white. Please be
advised that this is normal.

Error Messages

In cases where Excel is either not available or supported, you may encounter the following error
messages:

=  This application does not support Excel reporting.
= No version Info available! Version of Excel is not supported.

= A report was not produced
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MANDATORY SETTING FOR EXCEL MACRO
SECURITY

In Microsoft Excel, complete the following steps:
1. From the Excel main menu, click Tools » Macro » Security to open the Security dialog box.

Security

Security Level | Trusted Sources

™ High. Only signed macros from krusted sources will be allowed
ko run. Unsigned macros are automatically disabled.

% Medium. You can choose whether or not ta run potentially
unsafe macros,

" Low {not recommended), You are not protected From
potentially unsafe macros. Use this sekting only if vou have
wirus scanning softbware installed, or wou are sure all
documents vou open are safe,

Wirus scannet(s) installed,

Ik I Cancel

2. Inthe Security Level and Trusted Sources tabs, set the options to match those in the table below.

Trust Al | Trust Access
Excel | Secunty | Instalied | to Visual
wErsion Level Addins | Basic Propect

2000 Medium | Checked i
2003 fedium | Checked Checked
xp Medium | Checked [ Cheacked
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THE OUTPUT EXCEL FILE

Default Format

Preview to Excel formats your Excel report on a column-by-column basis. The type of data presented
within each column dictates that column’s format. The manner in which the data is presented is described
below.

= Hours are formatted as Numbers.

=  Amounts or Currencies are formatted as Accounting.

= Percentages are formatted as Percentage.

= Accounts (for columns that only contain Account Numbers) are divided.
= Cells with alphanumeric characters are separated into two cells.

= For multiple reports, each report is displayed in a separate worksheet.

= Each worksheet contains up to 700 pages. Once the report exceeds the maximum of 700 pages, it
automatically transfers subsequent pages to the next worksheet.
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GCSP EXCEL ADD-IN

Use the GCSP settings add-in to format reports generated from Print Preview to Excel and Send to
Excel. A GCSP Settings button becomes available in Excel automatically after you install the add-in.
To install this add-in, complete the following steps:

1. Select Tools » Add-Ins.

2. Select the GCSP Settings check box, or browse for \Program
Files\Deltek\GCSPremier\Programs\GSRPTLYT.xla.

@]  Uninstalling GCS Premier Version 4 removes the GCSP Settings Add-in.

Page Tab

The Page tab of the Settings dialog box enables you to show page breaks, roll-up page headers, and
bold page headers. Select Show page breaks to display page breaks automatically and Roll-up page
headers to designate a single header for all pages. Bold page headers automatically bolds your page
header fonts. Page headers include lines for company name, report title, and column titles. Click Apply
to apply the selected options without closing the Settings dialog box. Click OK to apply your selections
and close the Settings dialog box.

Color and Lines Tab

The Color and Lines tab of the Settings dialog box contains two options:

= Color negative values allows you to change the color for negative values to red.
= Show the grid lines allows you to display grid lines.

Click Apply to apply your choices without closing the Settings dialog box. Click OK to apply your choices
and close the Settings dialog box.
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REPORTS SUPPORTED BY PREVIEW/SEND TO
EXCEL

Listed below are the reports that allow Preview/Send to Excel:

Timesheet and Labor Distribution Module
= Timesheet Edit by Account Report

= Timesheet Edit by Employee Report

= Timesheet History by Account Report

= Timesheet History by Employee Report

= Labor Utilization Report

Payroll and Human Resources Module
= Deduction Summary Report
= Detail Employee Earnings

= Accrued Leave Report & Inquiry

Accounts Payable Module
=  Open A/P Report
= Voucher Edit Report

Accounts Receivable Module
= Aged A/R Report

= Unbilled A/R Report

=  Print Billing Worksheet (Contract)

General Ledger Module

= Balance Sheet

= Bank Reconciliation File Report

= Bank Reconciliation Summary Report
= F/S Code Summary Report

=  GJ/L Details Report

= Income Statement

= Trial Balance Report & Inquiry

= Contracts and Pools Module
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Cost/Revenue Summary
Job Status Report
Co-Wide Pool Report & Calculations

Divisional Pool Expense Report & Calculations

Executive Information Module

Balance Sheet

Income Statement

F/S Code Summary Report
Job Status Reports

Aged A/R Report

Labor Utilization Report

Delteki.
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